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This document describes the required steps for getting started with the 16 channel SV3C LVDS Signal 

Generator.  Hardware connection and software installation steps are provided, followed by a simple 

demonstration of how to set up and start the signal generator. 

• (QTY = 1) SV3C-32 Channel Personalized SerDes Tester 

• (QTY = 2) Common Mode Controller Board 

• (QTY = 3) 12 V power supply units (manufacturer part number CUI SDI65-12-U-P5) 

• (QTY = 2) Huber/Suhner MXP to MXP cable harnesses (manufacturer part number 

MF53/2x8A_21MXP/21MXP/305_1)  

• (QTY = 2) Huber/Suhner MXP to SMA cable harnesses (manufacturer part number 

MF53/2x8A_21MXP/11SK/305)  

• (QTY = 1) Common Mode Controller Interconnect Cable (see Figure 4) 

• (QTY = 1) USB2 mini B cable for connection between the SV3C and a personal computer 

• (QTY = 1) Personal computer.  See the “System Requirements” the “Introspect ESP Software 

Installation” sections of this document for further details. 

The location of the SV3C MXP and Molex connectors is shown in Figure 1, and the complete pinout for 

MXP signals is provided in Table 1.    



 

                    

                                         

 

 

 

 

 

MXP 

Top View 

 

 

1 TX1P 1 TX9P 1 TX17P 1 TX25P 

2 TX1N 2 TX9N 2 TX17N 2 TX25N 

3 TX2P 3 TX10P 3 TX18P 3 TX26P 

4 TX2N 4 TX10N 4 TX18N 4 TX26N 

5 TX3P 5 TX11P 5 TX19P 5 TX27P 

6 TX3N 6 TX11N 6 TX19N 6 TX27N 

7 TX4P 7 TX12P 7 TX20P 7 TX28P 

8 TX4N 8 TX12N 8 TX20N 8 TX28N 

9 TX8N 9 TX16N 9 TX24N 9 TX32N 

10 TX8P 10 TX16P 10 TX24P 10 TX32P 

11 TX7N 11 TX15N 11 TX23N 11 TX31N 

12 TX7P 12 TX15P 12 TX23P 12 TX31P 

13 TX6N 13 TX14N 13 TX22N 13 TX30N 

14 TX6P 14 TX14P 14 TX22P 14 TX30P 

15 TX5N 15 TX13N 15 TX21N 15 TX29N 

16 TX5P 16 TX13P 16 TX21P 16 TX29P 

                   
         

                

     
         

     
           

     
          

     
           

            

            

         

Figure 1: SV3C MXP, Molex, USB and power connector locations 

 



The setup of the SV3C LVDS Generator requires two Common Mode Controller Boards.  Though the 

Common Mode Control Boards are identical and interchangeable, they are described below in terms of 

Board # 1, which is used for LVDS output channels 1-8, and Board # 2, which is used for LVDS output 

channels 9-16.  The locations of the MXP connectors and the Auxiliary Control Port SCSI connectors are 

shown below in Figure 2 and Figure 3.  The complete pinouts for MXP signals are provided in Table 2. 

 
 

                                        

  

 

 
 

                                        

  

                      
                     

       
     

      
      

                                              

     
          

                  

     
              
                

                      
                     

       
     

      
      

                                               

     
           

                  

     
               
                

Figure 2: Common Mode Controller Board # 1, MXP, Auxiliary Control Port and power connector locations 

 

Figure 3: Common Mode Controller Board # 2, MXP, Auxiliary Control Port and power connector locations 

 

 



 

 

MXP 

Top View 

 

 

1 TX1P 1 TX1P OUT 1 TX9P 1 TX9P OUT 

2 TX1N 2 TX1N OUT 2 TX9N 2 TX9N OUT 

3 TX2P 3 TX2P OUT 3 TX10P 3 TX10P OUT 

4 TX2N 4 TX2N OUT 4 TX10N 4 TX10N OUT 

5 TX3P 5 TX3P OUT 5 TX11P 5 TX11P OUT 

6 TX3N 6 TX3N OUT 6 TX11N 6 TX11N OUT 

7 TX4P 7 TX4P OUT 7 TX12P 7 TX12P OUT 

8 TX4N 8 TX4N OUT 8 TX12N 8 TX12N OUT 

9 TX8N 9 TX8N OUT 9 TX16N 9 TX16N OUT 

10 TX8P 10 TX8P OUT 10 TX16P 10 TX16P OUT 

11 TX7N 11 TX7N OUT 11 TX15N 11 TX15N OUT 

12 TX7P 12 TX7P OUT 12 TX15P 12 TX15P OUT 

13 TX6N 13 TX6N OUT 13 TX14N 13 TX14N OUT 

14 TX6P 14 TX6P OUT 14 TX14P 14 TX14P OUT 

15 TX5N 15 TX5N OUT 15 TX13N 15 TX13N OUT 

16 TX5P 16 TX5P OUT 16 TX13P 16 TX13P OUT 

 

The Common Mode Controller interconnect cable is shown below in Figure 4.  This cable is used to 

connect the 12-pin GPIO connector on the SV3C to the SCSI connectors on each of the Common Mode 

Controller Boards.  The SCSI connector for the first Common Mode Controller has a silver stripe on it, as 

shown in Figure 4. The required connection is shown schematically in Figure 5. 

  



                     
 

 

 

The overall connection of the SV3C and the two Common Mode Control Boards is shown in Figure 5.  

MXP cable harnesses are shown by the red and white solid arrows, and both the Common Mode 

Controller Interconnect Cable and USB cable are shown by thin red arrows.  Power connections are 

required but not shown. 

 

                        

 

            
               
              

            
               
              

         
               

          
       

   

          
       

          
         

     
         

     
         

     
         

              
                

               
                

            
              
               

     

            
                 

            
                 

Figure 5: Connection of the PC, SV3C and Common Mode Control Boards 

 

Figure 4:  Common Mode Controller Interconnect Cable 

 



The Introspect ESP Software provides an easy-to-use environment for device characterization and test-

plan development.  To run the software, the following components are required: 

• A PC installed with Windows XP, Vista, or Windows 7, 8, 10 or 11. 

• The Introspect ESP install executable.  Note that to use the 16 channel SV3C LVDS Generator 

form factor in software, Introspect ESP version 22.3 or later is required. 

• USB device drivers (refer to the driver installation instructions later in this document) 

 

 

 

a) Quit any Introspect ESP programs before starting the installation process.  

b) If this is your first installation of the Introspect ESP Software, open the “README_Install.txt” file 

located in the installation files and install any prerequisite components by consulting the 

“Windows Software Requirements” section. 

 

 

a) From the directory containing the installation files, double-click the "IntrospectESP_Installer.exe" 

executable and follow the on-screen instructions.  

b) When prompted, specify the location where you want to install the Introspect ESP software. The 

default location is Program Files -> Introspect. The software will be installed into a sub-folder 

specifying the version number. 

 
A fully functional command line version of the Introspect ESP software is also available for 

MacOS and Linux. However, this quick start guide will focus on the Windows version. 



 

 

c) By the simple press of a button, the Introspect ESP software will install its own embedded version 

of Python, along with its required 3rd-party modules. This means that any previous Python 

installations on the host computer will not be affected by the Introspect ESP Software. 

 

 

a) Towards the end of the installation, you will be asked to provide either an activation key or a 

license file for the software.  

b) If you have a valid activation key, simply select the “Use Activation Key” option and enter your 

activation key. The installer will then automatically generate the required license files. 

c) If you were provided with a license file instead, select the “Use Existing License” option and the 

installer will help you copy it into the new installation folder.  

d) If you do not have any of the above, select the “Get a New License” option and the installer will 

provide you with information that needs to be sent to Introspect Technology in order to obtain 

one. Copy and paste that information to request a license via: license_support@introspect.ca. 

e) Upon receipt of the valid license files, please place them into the following directory:  

 

 

 

 

  

 
The selected installation directory must be a new location – it cannot be the same as a previous 

installation. 

C:\[Your Introspect Installation Folder]\Licenses 

 
The installer creates a folder called “Introspect” under the “My Documents” folder of your 

account. This folder is where Test Procedures are usually saved. 

 

file:///C:/Users/Philippe/Downloads/license_support@introspect.ca


 

a) Double-click on the "IntrospectESP" shortcut on your Desktop 

and you should see the first "welcome" window of the GUI. 

Please specify the hardware (the form factor) as 

“SV3C_32T16RC4G_LVDS” and Press “Next” to continue.  

 

 

 

 

 

 

 

 

 

 

 

 

 

b) Select the option “Create a new Test” and click the “Next” button. 

 

 

 

 

 

 

 



c) With a valid license in the “Licenses” 

directory, the following GUI screen should 

come up, which indicates that the 

Introspect ESP Software has been 

successfully installed. 

 

 

 

 

 

 

 

The “[IntrospectESP_install_dir]\Doc” folder contains the following information on the software: 

• “IntrospectESP_UserManual.pdf” is the user manual for the Introspect ESP Software and is 

recommended reading for all users. 

•  “svt.html” and “iesp.html” provide documentation on the Python component classes and lower-

level functions specific to the selected form factor. Both files can be found in 

“C:\[IntrospectESP_install_dir]\Doc\FormFactors\SV3C_32T16RC4G_LVDS. These are intended for 

intermediate and advanced users. 

 

 

 

“Application Notes” can be found in the “C:\[IntrospectESP_install_dir]\Doc\” sub-folder and have more 

advanced features, often in the form of tutorials. 

 
Both the user manual and the above html files are also conveniently available from the “Help” 

pull down menu located on the top right of the main Introspect ESP window. 



The following procedure will allow for automated FTDI driver installation. 

 

For this procedure, connect the SV3C to the PC using the USB2.0 mini B cable, as shown in Figure 6 

below, and power on the module. To allow for driver installation, the PC should be connected to the 

internet as well. 

 

 

               
 

 

 

 

 

The PC should display the message “New drivers successfully installed” once the installation process is 

complete. If this does not occur, see the troubleshooting notes at the end of this section. 

 

 

  

             

            

            

Figure 6: USB cable connection for USB driver installation  

 



 

 

a) If it is not already open, launch the Introspect 

ESP Software and select the 

“SV3C_32T16RC4G_LVDS” form factor.  From 

the main GUI window, click the 

“IESP/SV3C_32T16RC4G_LVDS” drop down 

menu and click “Connect”, as shown here. 

Establishing the connection should take a 

couple of seconds. 

 

 

 

 

b) To verify the connection, select the 

“IESP/SV3C_32T16RC4G_LVDS” drop down 

menu and click “Status”. A dialog window 

should confirm that the SV3C module is 

connected, as shown in the example here. 

Also, the status indicator in the bottom left 

corner of the main GUI window should be 

solid green, indicating that the SV3C unit is 

connected and ready. 

 

 

If the connection cannot be established, or if the drivers cannot be found or automatically installed, 

please refer to the “FTDI Driver Manual Installation” Appendix to install the required drivers. 

 

 



The following step-by-step guide will allow the user to set up the SV3C LVDS Generator to transmit data 

on one or more channels.  The following section is intended to provide an overview of how to use the 

Introspect ESP GUI and highlight several of the GUI’s key features.  

 

 

For this procedure, please attach the hardware components as shown previously in Figure 5.  Also 

connect the generator to a device under test (or to an oscilloscope) as required.   

 

 

a) If you have not done so previously during the USB driver installation procedure, launch the 

Introspect ESP Software, select the “SV3C_32T16RC4G_LVDS” form factor and create a new Test 

Procedure. 

 

b) In the top left corner of the main GUI 

window, select the “IESP/ 

“SV3C_32T16RC4G_LVDS” drop down menu 

and click the “Connect” option. Establishing 

connection should take a couple of seconds.  

 

 

 

 

 



c) To verify the connection between the PC and 

the SV3C module, select the 

“IESP/SV3C_32T16RC4G_LVDS” drop down 

menu and click the “Status” option.  A dialog 

window should confirm that the SV3C module 

is connected, as shown here, and will list the 

detected personality / firmware version.  

 

 

d) By default, when started in the “SV3C_32T16RC4G_LVDS” form factor, the GUI contains a single 

line of code in the “Test Procedure” tab and a single component in the “Components” section, as 

shown below. The globalClockConfig1 component is used to specify the data rate of the SV3C 

module.  The default data rate is 4000 Mbps as shown. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

a) The SV3C LVDS Generator output is set by the “txChannelList” component.  To add this 

component to the test procedure, first click the “Add” button as shown below.  Next, in the “Add 

Component” window, select the “txChannelList” component, and finally click the “Add 

Component” button, as shown below. 

 

 

b) A new “txChannelList” component will be added in the “Components” window on the left side of 

the GUI, and a single line of code will be added automatically to the end of the “Test Procedure” 

window at the bottom of the GUI.  All of this is shown in the figure on the following page. 

 



 

 

c) To modify the TX channel list properties, click on “txChannelList1” in the “Components” window 

on the left side of the GUI, as shown above.   

• The “channels” property sets the number of active channels and may include any set of 

channels numbered between 1 and 16. 

• The “patterns” property sets the pattern or patterns on a per-channel basis. 

• To use the common mode controller boards in the setup, the “terminationBoardInUse” 

property must be set to “True” as shown. 

• The “termBoardCommonModeVoltagesPN” property sets the common mode voltage for all 

channels listed in the “channels” property mentioned above.  Common mode voltage for the 

P and N terminals for each channel are specified separately for each channel. 

• There is context help available in the GUI for setting each txChannelList property.  The context 

help for the “termBoardCommonModeVoltagesPN” property is shown in the figure above. 

 



d) Additional help and further on-line documentation for components is available from the pull-

down menu Help -> Component Classes.  Other on-line resources are available through the 

same pull-down menu. 

 

 

a) Click the “Run” button at the bottom of the main GUI window as shown below, or use the F5 

shortcut key, to start the test. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

b) After clicking the “Run” button, the GUI will automatically change from the “Params” tab to the 

“Log” tab where you can find information about the currently executing procedure. Any errors 

occurring during the test run will be reported here.  An example set of log messages is shown in 

the figure on the following page.   Check the DUT or oscilloscope to verify output of the SV3C 

LVDS Generator at this point, following the test execution.  The generator output continues to 

run after the test procedure has completed. 



 

 

 

 

 

 

 

 

 

 

 

 

 

a) From the pull-down menu, select “File -> Save” or “File -> Save As…“ to save the contents of the 

test folder.   The name of a saved folder will appear at the top of the test folder window, such as 

“LVDS Generator Example” as shown here.   This concludes this SV3C LVDS Generator software 

demonstration.    

 

 

 

 

 

 

 

 

 



SV3C Personalized SerDes Tester Data Sheet 

• MK-D011E-E-18143 - SV3C Data Sheet 

 

SV1C Common Mode Controller Data Sheet 

• EN-D029E-E-21129 - SV1C Common Mode Controller Data Sheet 

  



The Introspect ESP Software communicates with the SPI Controller via an FTDI device (connected via 

USB). If you don’t already have required FTDI drivers installed on your Windows computer, or if the 

automated driver detection presented earlier in this document was unsuccessful, you will need to 

download them from the FTDI web site.  To do this, follow the instructions found at  

http://www.ftdichip.com/Documents/InstallGuides.htm  

The latest drivers can be found at  

http://www.ftdichip.com/Drivers/D2XX.htm 

Note that the driver version used in our product development is 2.12. 

You may wish to use the “usbview” utility program linked to on the following FTDI page: 

http://www.ftdichip.com/Resources/Utilities.htm 

This program will allow you to check that your computer can “see” the FTDI device over USB. 

 

 
 

 

 

 
 

http://www.ftdichip.com/Drivers/D2XX.htm
http://www.ftdichip.com/Resources/Utilities.htm
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The information in this document is subject to change without notice and should not be construed as a 

commitment by Introspect Technology. While reasonable precautions have been taken, Introspect 

Technology assumes no responsibility for any errors that may appear in this document.   

 


